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Reviewing the Essentials > Text Caption Pre-Editing > Edit a Text Capture Template

5. Edit the template.

scroll down to the part of the document shown below

,'. CaptureTextTemplates_English.rdl - Notepad = |EI|1|

File Edit Format View Help
<Event Name="RightClick" Template="Ri

ht click the %s menu”/>a|

<Event Name="RightDBC1ick" Temp1ate=“Doub?e—c1ick the %s menu"/>
<Event Name="MiddleDBClick" Template="Double-click the %s menu"/>
<Event Name="KeyPress" Template="Press %s key for %s menu"/>

</0Object> (=l
< ate= select the ¥s menu Ttem
<Event Name="LeftDBCIick™ Template= Double-click the %s menu
item" />
<Event Name="RightClick" Template="Right Click the %s menu
item" />
<Event Name="RightDBCTick" Template="Double-click the %s menu
item" />
<Event Name="MiddleDBClick" Template="Double-click the %s menu
item" />

=

This is the part of the document that controls the words “Select” and “menu
item.” If you edit the text in this part of the template, the automatic text
captions created during the recording process will allow you to skip much of
the editing process during the post-production phase.

replace the word Select with Choose

replace the words menu item with command

Your changes should match the picture below.

,i CaptureTextTemplates_English.rdl - Notepad ! | Ellll

File Edit Format View Help

<Event Name="RightClick" Temp1ate=“Ri?ht Click the %s menu”/> |
<Event Name="RightDBClick" Template="Double-click the %s mgu=
<Event Name="MiddleDBClick” Template="Double-click the %s {::) >
<Event Name="KeyPress" Template="Press %s key for %s menu"
</0Object> —
<Object Name="MenuItem" DefaultTemplate="
[commarn
<Event Name="LeftDBC1lick" Template="Double-click the %s menu

item" />
<Event Name="RightClick"” Template="Right Click the %s menu

item" />
<Event Name="RightDBCTick" Template="Double-click the %s menu

item" />

<Event Name="MiddleDBClick" Template="Double-click the %s menu

6. Save and close the Notepad file.
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Working With PowerPoint

If you have created a presentation using Microsoft’s PowerPoint, you can import the
presentation into an existing Captivate project, or create a new project that uses the
PowerPoint slides. That capability is nothing new to Captivate.

One welcome new feature in Captivate 4 is the ability to create a link between
Captivate and PowerPoint. Using this workflow, any changes made to the original
PowerPoint presentation can be shown in the Captivate project. In older versions of
Captivate, there was no link between the two programs and changes made in the
original PowerPoint presentation required a fresh import into Captivate.

Note: As mentioned in the System Requirements section on page vi,
Microsoft PowerPoint must be installed on your computer before you
can import PowerPoint presentations into Captivate.

Student Activity: Import a PowerPoint Presentation
1. Create a new project from a PowerPoint presentation.

from the Create Project area of the Welcome Screen, click From MS
PowerPoint

L+ From MS PowerPoint = |
=~

The Open dialog box appears.

if you own PowerPoint 2007, open PowerPointPresentation.pptx from
the Captivate4_BeyondEssentialsData folder; if you own an older version of
PowerPoint, open PowerPointPresentation_v97-2003.ppt from the
PowerPoint2003File folder

The PowerPoint presentation is loaded and the Convert PowerPoint
Presentations dialog box appears, offering a few controls over how the
presentation is imported.

The presentation consists of 43 slides, all of which contain transitions, builds
and, to be quite honest, an annoying sound effect (you won’t hear the sound
until you preview the project, which you will do soon enough).

2. Set the import options.

ensure that Selected Slides: 43 of 43 appears at the bottom of the dialog
box (if not, click the Select All button now)

from the Advance slide drop-down menu, select On mouse click
(if necessary)

at the lower right of the dialog box, ensure Linked is selected |+ Linked

26
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Importing and Branching > Working With PowerPoint > Edit a PowerPoint Presentation

4. Remove the sound effect from a PowerPoint presentation.
If you are using PowerPoint 2007:

select the Animations tab at the top of the window

at the right of the Ribbon, select [No Sound] from the Transition Sound
drop-down menu

click the Apply to All button

J_.', Transition Sound: | [Mo Sound)] -
_ijl_ Transition Speed: |5low s
il Apply To All

If you are using PowerPoint 2003:

choose View = Task Pane

from the Slide Transition Panel at the right of the window, choose
Sound = No Sound

click the Apply to All Slides button Q

5. Save the PowerPoint changes.

click the Save PPT button

The changes you just made to the PowerPoint presentation are saved, the
presentation is closed and the slides are automatically reimported into
Captivate.

6. Preview the Captivate project.
Ahhh, that’s much better. The annoying sound effect is gone. However, you

probably noticed that there is an equally annoying click sound as you move
from slide to slide. Let’s go ahead and get rid of that.

7. Close the preview (keep the project open).
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Accessible Projects = Shortcut Keys > Add Shortcut Keys

4. Attach a combination shortcut to a click box.

go to Slide 3
on the Timeli D ight-click the Click Box and choose Properties

on the Click Box tab, click the Select keys button
select Attach a shortcut
select ALT

select F from the Letter drop-down menu

x

rMouse didk

¥ Allow mouse dicks

= Select this check box to allow the user to dick in the

contral,
|_|W¥ Attach a shortout

R,% [V Indude Mumeric Keypad [0-9] Keys

[ cTRL [~ sHIFT W AT
Backspace ﬂ
Caps Lock

Delete
Down Arrow
End

Enter =
J | _'l_I
Letter: v or number: I = l

Current shortcut: ALT+F

&9 Leamn more.. oK I Cancel |
click OK
click OK

5. Test the shortcut keys.
select Slide 1
press [F10] on your keyboard to preview five slides
when the first slide appears, press [Enter] to go to the next slide
when the second slide appears, press [Enter] to go to the next slide

when the third slide appears, press [alt] [f] to go to the next slide

The keys should have worked as expected. Let’s see what happens if you play
the lesson through a Web browser.

6. Close the preview.
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7.

10.

11.

12.

Preview via a Web browser.
press [F12] on your keyboard to preview in a Web browser
when the first slide appears, press [Enter] to go to the next slide
when the second slide appears, press [Enter] to go to the next slide

when the third slide appears, press [alt] [f] to go to the next slide

Ooops! The [alt] [f] keys probably worked and you advanced to the next
slide. However, it's also possible that the [alt] [f] keys opened the File menu
in your Web browser. Since you cannot stop keys from activating Web browser
functions, it's probably best to change the key to simply the letter f.

Close the browser window and return to the Captivate project.

Edit assigned shortcut keys.
go to Slide 3

on the Timelin D ht-click the Click Box and choose Properties

on the Click Box tab, click the Select keys button

select Attach a shortcut

deselect ALT (remove the check mark from the box)
ensure F is still selected from the Letter drop-down menu
click OK

click OK

Save your work.

Preview the project in a Web browser and ensure the shortcut keys work as
expected.

Close the browser window and return to the Captivate project.
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Note: If you are
unable or
unwilling to
create your own
buttons via the
button
generator site
mentioned
during the
activity on this
page, you will
find three
custom buttons
in your data
files folder that
you can use
instead. The
buttons are
located in the
CustomButtons
folder (within
the Images
folder).

Custom Buttons

During the Confidence Check on the previous page, you learned how to add a
Perpetual button widget to your project. As cool as they are, Perpetual buttons have
a down side: you have no way of altering the appearance of the buttons unless you
have Adobe Flash (and know how to use it).

It's a good bet that you have also already discovered how to insert both Text and
Image buttons (via Insert > Standard Objects) onto project slides. Also, in the
course of that discovery, you have likely come to the realization that Text buttons
work well enough but aren’t the greatest looking things in the world. Image buttons,
while nicer looking than Text buttons, are somewhat limiting given the fact that
Captivate only ships with a handful of sample buttons; and you cannot edit them
(unless you have Photoshop or similar image editing application). In an ideal world,
you could create image buttons quickly, on-the-fly... and for free.

There’s good news ahead for you. During the activities that follow, you will learn how
to create three custom buttons. Each button will contain a different word: Start, The
and Lesson. Because buttons in Captivate include a rollover behavior by default,
when you interact with your button during playback, the first thing you will see is the
word Start. As you roll over the button with the mouse, the text will change to The.
And as you click the button, the word will change a final time to Lesson.

Student Activity: Create Custom Buttons

1. Access a button generator site on the Web.

using any Web browser, go to www.buttongenerator.com

If you do not want to create your own buttons, or are unable tor==2ess the
buttongenerator site, see the Note in the margin of this page. D

If the buttongenerator.com Web site is down, try accessing http://
cooltext.com/Buttons instead. While the steps to create the buttons will be
a bit different on this site, they will be similar enough for you to create a few
buttons for use in Captivate.

2. Select a generator.

click the Web Button Generator link from the Select a generator area

 Go | .Disdaimer,,
H_::IB_J‘( Sigm Up
ey, (<< BACK)
':.a:ﬂmum—

Web Button Generator
Create multipurpose web buttons
for your website.

select Only Free Buttons from the Show drop-down menu

Select the web button you wish to edit :

Show : IOnI).r Free Buttons j
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Project and Design Templates > Desigh Templates > Confidence Check

4.

5.

Confidence Check

Explore the project to confirm that changes have been made.

go to Slide 2

The Caption Type and Font size now match those you specified in the
template.

go to Slide 3
The appearance of the highlight box has been fixed as well.

Just as interesting as the changes that you might have been expecting in the
FixMe project, notice that the font used in the buttons (on Slides 1 and 2), and
the failure captions throughout the project have all been updated. While the
appearance has been changed, the font used in those objects is Arial, the
default font used in the Design template. Since you did not update those
objects, the default template properties for all of the template’s objects have
been applied to all of the objects in the FixMe project. In the future, it would
be a good idea to set all of the properties of a Design template object prior to
applying the template to a project.

Save your work and close the project.

1. Open your Design template (File = Open).
2. Go to Slide 3.
3. Show the Properties of the failure caption and change the
Font attributes to Verdana 10.
4. Go to Slide 4. |
J I
5. Show the Properties of the button and change the Font / / N
attributes to Verdana 10. ~
6. Go through the rest of the template making changes as you see fit (generally

10.

11.
12.

13.

speaking, the Font attributes of the objects should be Verdana 10.
Save and close the template.
Open the FixMe project.

On Slide 1, notice that the button’s Font attributes have not been updated,
even though you updated the template.

Go to Slide 3 and notice that the Font attributes in the failure caption have not
been updated.

While it might seem that the template isn’t working, keep in mind that there
isn’t a live link between the project and its template. If you want the changes
to appear in the project, you'll need to reapply the Design template.

Apply your Design tem Dl to all of the slides in your project.

Scroll through your slides and notice that the buttons and failure captions
have updated and now match the formatting from your template.

Save and close the project.
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A screen appears confirming your username and password (you should write
both bits of information down in the margin of this page so you won’t forget
them).

/& click Continue

The Site Menu screen appears.

3. Set up the Home Page.

/E click Home Page from the Setup Menu area

/E fill in the Headline and Body Copy areas as you see fit
(customers who access the LMS will see the
information you type here)

/£ click the Save Changes button
/E click the Back to Site Menu link (the link is in the upper right of the page)

4. Logout from the Inquisiq control panel.

chcut'

/E click Logout in the upper right of the window
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